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Throughout EEL3701, we will be using Intel’s Quartus Prime software suite to design, simulate, and compile 
digital circuit designs for use on the DE10-Lite FPGA Development Board. The installation of Quartus Prime 
will take multiple steps. Make sure to install both Quartus and one simulator, either ModelSim or Questa. I would 
recommend using ModelSim as your simulator because it does not require a license. The Questa simulator has a 
more complicated setup but works better on Linux. 
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Quartus Installation Instructions 
Quartus Installation for Windows 10/11 
1. Go to the Quartus Prime Lite 23.1.1 Windows download page and select the “Individual Files” tab of the 

website, as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download, the following, as shown with arrows on the left: 

a) Quartus® Prime (includes Nios II EDS) 
b) MAX® 10 FPGA device support 
c) MAX® II, MAX® V device support 
d) Cyclone® V device support 

    

https://www.intel.com/content/www/us/en/software-kit/825278/intel-quartus-prime-lite-edition-design-software-version-23-1-1-for-windows.html
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3. Select each of the files specified above for download. You may need to accept license agreements for some of 

the downloaded files.  
4. After the Quartus software has finished downloading, run the below installation file to install the Quartus 

software. 
  QuartusLiteSetup-23.1std.1.993-windows 
Note that the numbers after the 23 might change as new versions become available. 
a) Windows may tell you that it is not safe to run this program with something like Windows protected 

your PC. Ignore this message. Select More info or something similar to get Windows to continue and 
then select Run anyway. 

b) Leave all default options in the installer and select Next each time it is necessary. 
c) When the Finish option is presented, de-select Launch USB Blaster II driver installation 

and Launch Quartus Prime Lite Edition and then select Finish. 
5. If you have a High DPI display, some Quartus programs such as the simulation editor will not look correct. To 

fix this problem, navigate to C:\intelFPGA_lite\23.1std\quartus\bin64 and find 
quartus.exe. Right click on quartus.exe and choose Properties. Click on the Compatibility tab 
and click on the button labelled Change high DPI settings. In the window that appears, check the 
checkbox next to Override high DPI scaling behavior and choose the System 
(Enhanced)option in the dropdown menu. Click OK on the High DPI settings window and then Apply on 
the properties window. 
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6. When the installation is done, run the Quartus software from the Start menu or the desktop 

shortcut. When a Quartus Prime 23.1 Lite Edition window appears (see below), 
select Launch Quartus Lite. I suggest that you drag the Quartus desktop icon into your 
Taskbar for easiest access. 

 

7. Once you get your DE10-Lite, attach it to your computer and complete the driver installation as specified 
below. This should work for both Windows 11 and Windows 10. 
a) Connect the USB-Blaster (DE10-Lite) to your PC. 
b) Open Device Manager. 
c) Locate USB-Blaster under Other devices. 
d) Right-click on USB-Blaster and select Update Driver. 
e) Choose Browse my computer for drivers. 
f) Select the Browse... button in the new window. 
g) Navigate to your Quartus installation directory: 

• This is typically found at: C:\intelFPGA_lite\23.1std\quartus\drivers 
 If you can't find this directory, try clicking "This PC" then you should be able to find the C: drive 

or the intelFPGA_lite folder. 
• Adjust the path according to your specific Quartus version (e.g., it may not be 22.1std for you).  
• Note: Stop at the drivers folder, i.e., do not go deeper by opening a folder within the drivers 

folder. 
h) Confirm the file path and click Next. 
i) If prompted by Windows Security: 

• Check the box for Always trust software from "Altera Corporation". 
• Click Install. 
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Quartus Installation for Linux 
The installation directions provided in this document were designed for default Ubuntu 22.04 LTS, as this is the 
most recent distribution that is officially supported by Quartus.  
1. Go to the Quartus Prime Lite 22.1.1 Linux download page and select the “Individual Files” tab of the website, 

as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download, the following, as shown with arrows on the left: 

a) Intel Quartus Prime (includes Nios II EDS) 
b) Intel MAX 10 FPGA Device Support 
c) Intel MAX II, Intel MAX V Device Support 
d) Intel Cyclone V Device Support 

  

https://www.intel.com/content/www/us/en/software-kit/773997/intel-quartus-prime-lite-edition-design-software-version-22-1-1-for-linux.html
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3. Select each of the files specified above for download. You may need to accept license agreements for some of 

the downloaded files.  
4. Open a terminal and navigate to your Downloads folder. We can then run the Quartus installer by issuing the 

following commands. Make sure that you do not run the Quartus installer as root! 
 
chmod +x QuartusLiteSetup-22.1std.1.917-linux.run 
 
./QuartusLiteSetup-22.1std.1.917-linux.run 
 

j) Leave all default options in the installer and select Next each time it is necessary. 
k) When the Finish option is presented, de-select Run the Quartus Prime Software and then select 
Finish. 

5. To allow easy access to your Quartus installation, create a text file called quartus.desktop using the text 
editor of your choice and copy the following contents into it. Make sure to change YOURUSERNAME to the 
username of the account that you installed Quartus for. 

[Desktop Entry] 
Version=1.0 
Type=Application 
Terminal=false 
Exec=/home/YOURUSERNAME/intelFPGA_lite/22.1std/quartus/bin/quartus 
Name=Quartus 
Icon=/home/YOURUSERNAME/intelFPGA_lite/22.1std/quartus/adm/quartusii.png 

a) If your distribution supports desktop icons, you can copy this file to your Desktop folder and it will work 
as a desktop shortcut 

b) To add a Quartus shortcut to your Apps menu, copy this file to ~/.local/share/applications, 
creating that folder if necessary. This was tested for GNOME 44. 

6. To allow Quartus to program your DE10-Lite board, we must add a udev rule enabling access to the USB-
Blaster programming hardware on the DE10-Lite. Create the text file /etc/udev/rules.d/51-
altera-usb-blaster.rules (requires superuser privileges) and populate it with the following: 
 
SUBSYSTEM=="usb", ATTR{idVendor}=="09fb", ATTR{idProduct}=="6001", MODE="0666" 
SUBSYSTEM=="usb", ATTR{idVendor}=="09fb", ATTR{idProduct}=="6002", MODE="0666" 
SUBSYSTEM=="usb", ATTR{idVendor}=="09fb", ATTR{idProduct}=="6003", MODE="0666" 
SUBSYSTEM=="usb", ATTR{idVendor}=="09fb", ATTR{idProduct}=="6010", MODE="0666" 
SUBSYSTEM=="usb", ATTR{idVendor}=="09fb", ATTR{idProduct}=="6810", MODE="0666" 
 

7. Restart your computer so that the new udev rules take effect. 
8. Many Linux systems still encounter a permissions error when trying to connect to the USB Blaster, even after 

adjusting the udev rules. This shows up in an “Unable to read device chain – JTAG chain broken” error while 
using the programmer. This can be remediated by adjusting the JTAG daemon’s settings. Run the following 
in a terminal: 

killall jtagd 
 
cd ~/intelFPGA_lite/22.1std/quartus/bin 
 
sudo mkdir /etc/jtagd 
 
sudo cp ../linux64/pgm_parts.txt /etc/jtagd/jtagd.pgm_parts 
 
./jtagd 
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9. You can verify that you are able to program your DE10-Lite by disconnecting and reconnecting it to your 

computer and running ./jtagconfig in the same terminal you ran the above commands. If your setup is 
correct, you should see output that looks like: 

1) USB-Blaster [1-2] 
    031050DD 10M50DA(.|ES)/10M50DC 

 
10. Run Quartus using either the .desktop file we made earlier or by running 

~/intelFPGA_lite/23.1std/quartus/bin/quartus. In the window that appears, select Run the 
Quartus Prime software and then select OK. 

 
11. Once you get your DE10-Lite, attach it to your computer and complete the driver installation as specified in 

https://www.terasic.com.tw/wiki/Altera_USB_Blaster_Driver_Installation_Instructions. 
  

https://www.terasic.com.tw/wiki/Altera_USB_Blaster_Driver_Installation_Instructions
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Quartus Installation for Intel Macs 
The best way to run Quartus on an Intel Mac is to dual boot Windows on your device by setting up Bootcamp. 
Students have also had success running the Windows version of Quartus through Parallels and other virtual 
machine software. Macs are not officially supported in this course, so you may need to do additional 
troubleshooting to get everything working correctly. See the Windows tutorials for installing Quartus and a 
simulator for more information. 
 
Quartus Installation for ARM Macs 
Quartus is x86 software and it has no native Mac port, so the best way to get it running is to run it in a Linux VM 
with the FEX x86 emulator. I have chosen to use UTM (free VM software) for this tutorial, but you could also do 
this in Parallels (paid) if you prefer. M1 Macs are not officially supported in this course, so you may need to do 
additional troubleshooting to get everything working correctly. 
1. Download UTM from https://docs.getutm.app/installation/macos/. You can download it for free by clicking 
Download from Github. Install UTM like you would install any other Mac application. 

2. Download Ubuntu Desktop 22.04’s ARM ISO from https://cdimage.ubuntu.com/jammy/daily-live/current/. 
The file should be called jammy-desktop-arm64.iso. 

3. Open UTM. Choose New VM, then Virtualize, then Linux. Make sure to use the default QEMU backend 
instead of Apple Virtualization. Quartus does not work on Apple Virtualization VMs yet. For the VM 
specifications, I recommend using at least 4096 MB of RAM but only one CPU core. From our testing, using 
multiple CPU cores in your VM will reduce Quartus’s performance substantially. The disk size should be at 
least 32 GB, though more is recommended.  For the boot image, select the jammy-desktop-arm64.iso 
you downloaded earlier. 

4. Start the virtual machine. Once you are booted into a desktop, choose Install Ubuntu and fill out the 
settings for the installer. Make sure to do a minimal installation because this will make sure there is sufficient 
disk space for Quartus to install. The installation will take 10-30 minutes depending on your computer. 

5. Once the installation is completed, shut down the virtual machine. From the UTM VM info page, remove 
jammy-desktop-arm64.iso from the disk drive. Power on the VM and log in using the username and password 
you set up during the installation. A first boot window will appear with information about Ubuntu, and you 
can click through it without installing any additional software. 

6. From the applications grid in the bottom left of the screen, open up a terminal and run the following commands 
to update your system and install necessary packages. These commands will have you enter your password, 
and what you type for your password will be completely hidden. This is normal. 

sudo apt update 
sudo apt upgrade 
sudo apt install curl 

7. Install the FEX x86 emulator by running the following command (all one line). You will be prompted to enter 
your password. 

curl --silent https://raw.githubusercontent.com/FEX-
Emu/FEX/main/Scripts/InstallFEX.py --output /tmp/InstallFEX.py && python3 
/tmp/InstallFEX.py && rm /tmp/InstallFEX.py 

8. The installer will prompt you for some options. You should have the installer download and install a rootfs 
automatically and set it as the default. You should be able to answer ‘y’ for every question it asks. 

9. In a terminal, enter the FEX environment by typing FEXBash. You can now follow the Linux installation 
instructions to install Quartus within the FEXBash environment. 

a. The only modification you need to make to the installation process is to insert FEXBash before the 
Exec command in the Quartus desktop entry if you decide to make one. 

10. Anytime you want to run Quartus, you must start it from within a FEXBash environment.  

https://docs.getutm.app/installation/macos/
https://cdimage.ubuntu.com/jammy/daily-live/current/
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Simulator Installation Instructions 
Modelsim Installation for Windows 10/11 
Modelsim is a free simulator that doesn’t require a license to use. We will install Modelsim 19.1, the last version 
of Modelsim released by Intel. 
1. Go to the Quartus Prime Lite 19.1 Windows download page and select the “Individual Files” tab of the website, 

as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download ModelSim-Intel FPGA Edition (includes Starter Edition, 

as shown by the arrow on the left. You may need to accept a license agreement. 

 
3. After Modelsim has finished downloading, run the following file to install it. 

https://www.intel.com/content/www/us/en/software-kit/664527/intel-quartus-prime-lite-edition-design-software-version-19-1-for-windows.html
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  ModelSimSetup-19.1.0.670-windows.exe 
Note that the numbers after the 19 might change as new versions become available.  
a) Windows may tell you that it is not safe to run this program with something like Windows protected 

your PC. Ignore this message. Select More info or something similar to get Windows to continue and 
then select Run anyway. 

4. When prompted to select which version of ModelSim you want to install, choose to install ModelSim Starter 
Edition 
a) Leave all default options in the installer and select Next each time it is necessary. 

 
5. Once the installation has completed, open Quartus and navigate to Tools->Options. In the Options 

window, select EDA Tool Options in the left panel. In the text box next to the ModelSim label, insert the 
path to Modelsim’s win32aloem folder. The default install location uses the path  
C:/intelFPGA_lite/19.1/modelsim_ase/win32aloem. Click OK to save the simulator settings. 
Now you will be able to use ModelSim from the Quartus VWF editor. 
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Modelsim Installation for Linux 
Modelsim is a free simulator that doesn’t require a license to use. We will install Modelsim 19.1, the last version 
of Modelsim released by Intel. This installation guide was designed for stock Ubuntu 22.04 LTS. 
1. Go to the Quartus Prime Lite 19.1 Linux download page and select the “Individual Files” tab of the website, 

as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download ModelSim-Intel FPGA Edition (includes Starter Edition, 

as shown by the arrow on the left. You may need to accept a license agreement. 

 
3. Open a terminal and Open a terminal and navigate to your Downloads folder. We can then run the ModelSim 

installer by issuing the following commands. Make sure that you do not run the ModelSim installer as root! 
 
chmod +x ModelSimSetup-19.1.0.670-linux.run 
 
./ModelSimSetup-19.1.0.670-linux.run 
 

4. When prompted to select which version of ModelSim you want to install, choose to install ModelSim Starter 
Edition 

https://www.intel.com/content/www/us/en/software-kit/664524/intel-quartus-prime-lite-edition-design-software-version-19-1-for-linux.html
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a) Leave all default options in the installer and select Next each time it is necessary. 

 
5. ModelSim uses a number of old 32-bit dependencies that we must install. Luckily, these packages can still be 

found in Ubuntu’s repositories. To install these packages, open a terminal and run 
 
sudo dpkg --add-architecture i386 
 
sudo apt update 
 
sudo apt upgrade 
 
sudo apt install libc6:i386 libncurses5:i386 libstdc++6:i386 \ 
lib32ncurses6 libxft2 libxft2:i386 libxext6 libxext6:i386 
 

6. To force Modelsim to use the libraries we just installed, we must edit its launch script. Use the text editor of 
your choice to edit ~/intelFPGA_lite/19.1/modelsim_ase/bin/vsim and make the following 
changes. You will need superuser privileges to edit this file. 
a) Change mode=${MTI_VCO_MODE:-""} to mode=${MTI_VCO_MODE:-"32"} 
b) Change vco="linux_rh60" to vco="linux" 
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7. Once the installation has completed, open Quartus and navigate to Tools->Options. In the Options 

window, select EDA Tool Options in the left panel. In the text box next to the ModelSim label, insert the 
path to Modelsim’s bin folder. The default install location uses the path  
/home/YOURUSERNAME/intelFPGA/19.1/modelsim_ase/bin. Click OK to save the simulator 
settings. Now you will be able to use ModelSim from the Quartus VWF editor. 

         
 
Unfortunately, the ModelSim GUI (used in Digital Design) does not work when following these installation 
instructions. I’m not sure if this is due to something being broken in ModelSim or if it can be fixed by installing 
additional dependencies. 
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Questa Installation for Windows 10/11 
1. Go to the Quartus Prime Lite 23.1.1 Windows download page and select the “Individual Files” tab of the 

website, as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download Questa*-Intel® FPGA and Starter Editions as shown with arrows 

on the left. You may need to accept a license agreement. 

  

https://www.intel.com/content/www/us/en/software-kit/825278/intel-quartus-prime-lite-edition-design-software-version-23-1-1-for-windows.html
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3. After the Quartus software has finished downloading, run the below installation file to install the Quartus 

software. 
  QuestaSetup-23.1std.1.993-windows.exe 

4. Note that the numbers after the 23 might change as new versions become available. 
a) Windows may tell you that it is not safe to run this program with something like Windows protected 

your PC. Ignore this message. Select More info or something similar to get Windows to continue and 
then select Run anyway. 

5. When prompted to select which version of Questa you want to install, choose Questa – Intel FPGA 
Starter Edition 
a) Leave all default options in the installer and select Next each time it is necessary. 

 
6. To prepare for acquiring a Questa License, we must find the hardware ID number of your network card. Intel 

uses this number to verify that your computer is licensed to use Questa. Open a Powershell window and run 
the command ipconfig /all. (without the period) This will list all of the network adapters connected to 
your computer. Look for your computer’s main WiFi or network card in this list and locate its Physical 
Address. The hardware ID number that you will put into the Intel website is your network adapter’s Physical 
Address with the dashes removed. Save this number for use when requesting your Questa License. For 
example, the ID number in the below screenshot is f4c88a3f40b2. 

 
7. Follow the instructions in Obtaining a Questa License 
8. Once you have obtained your Questa license, copy it to a safe folder where it won’t accidentally get deleted. 

This tutorial assumes that you create the folder C:\intelFPGA\licenses and copy your license file there.  
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9. We need to set the LM_LICENSE_FILE environment variable globally so that Questa knows where to find 

the license file.  
a) In the Start menu, search for Edit the system environment variables.  
b) Click the Environment Variables button in the bottom right corner of the window that appears.  
c) Under the System Variables section (bottom half of the window), click New.  
d) In the window that appears, type in LM_LICENSE_FILE for the variable name. To set the variable’s value, 

click the Browse File button in the bottom left corner of the window and navigate to where you stored 
your license file. Double click on the license file to save its path to the environment variable. 

e) Click OK to confirm the new environment variable. 

       
 

 
10. Restart your computer for your changes to take effect. 
11. Once your computer reboots, open a command prompt (type cmd in the Start menu) and enter lmutil 
lmdiag to confirm that your license is found correctly. If your license cannot be verified, double check that 
your LM_LICENSE_FILE environment variable is set correctly. 

12. By default, Questa aggressively optimizes your circuit designs so much that the outputs of your simulations 
will not be visible in the Quartus VWF viewer. To fix this, we need to replace the VWF viewer’s library file 
with a modified version that sets Questa to not optimize your designs while simulating. Download 
edt_wedtq.dll (in the provided zip file, quartus22.1_installation_library.zip) and copy it into the folder 
C:\intelFPGA_lite\23.1std\quartus\bin64. Make sure to replace the older version of this file 
in the destination.   
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13. Open Quartus and navigate to Tools->Options. In the Options window, select EDA Tool Options 

in the left panel. In the text boxes next to the Questa and Questa – Intel labels, insert the path to Questa’s bin 
folder. The default install location uses the path C:/intelFPGA/23.1std/questa_fse/win64. Click 
OK to save the simulator settings. Now you will be able to use Questa from the Quartus VWF editor. 

    
 
Please note that using Questa from its main GUI (such as in Digital Design) leads to the over-aggressive 
optimization that can break some simulations. I haven’t used Questa much yet, but if I find a workaround to make 
the Questa GUI behave properly then I will update this document. 
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Questa Installation for Linux 
The installation directions provided in this document were designed for default Ubuntu 22.04 LTS, as this is the 
most recent distribution that is officially supported by Quartus.  
1. Go to the Quartus Prime Lite 22.1.1 Linux download page and select the “Individual Files” tab of the website, 

as shown in the red rectangle. (Note that newer version may be available but should NOT be installed.) 
2. You only need to download Questa – Intel FPGA Edition as shown with arrows on the left. You 

may need to accept a license agreement. 

  

https://www.intel.com/content/www/us/en/software-kit/773997/intel-quartus-prime-lite-edition-design-software-version-22-1-1-for-linux.html
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3. Open a terminal and navigate to your Downloads folder. We can then run the Questa installer by issuing the 

following commands. Make sure that you do not run the Questa installer as root! 
 
chmod +x QuestaSetup-22.1std.1.917-linux.run 
 
./QuestaSetup-22.1std.1.917-linux.run 
 

4. When prompted to select which version of Questa you want to install, choose Questa – Intel FPGA 
Starter Edition 
a) Leave all default options in the installer and select Next each time it is necessary. 

 
5. To allow easy access to your Questa installation, create a text file called questa.desktop using the text 

editor of your choice and copy the following contents into it. Make sure to change YOURUSERNAME to the 
username of the account that you installed Questa for. 

[Desktop Entry] 
Version=1.0 
Type=Application 
Terminal=true 
Exec=/home/YOURUSERNAME/intelFPGA/22.1std/questa_fse/bin/vsim 
Name=Questa 

a) If your distribution supports desktop icons, you can copy this file to your Desktop folder and it will work 
as a desktop shortcut 

b) To add a Quartus shortcut to your Apps menu, copy this file to ~/.local/share/applications, 
creating that folder if necessary. This was tested for GNOME. 
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6. To prepare for acquiring a Questa License, we must find the hardware ID number of your network card. Intel 

uses this number to verify that your computer is licensed to use Questa.  
a) Open a terminal and run the command ip link. (without the period)  
b) Look for an adapter named eth0 or enp0sXX. Under that entry, look for a line starting with link/XXXX 

followed by a series of digits and letters. This series of digits and letters (without colons) is your network 
card ID. Save this number for use when requesting your Questa License. For example, the ID number in 
the below screenshot is 001d098ebed3. 

 
7. Follow the instructions in Obtaining a Questa License 
8. Once you have obtained your Questa license, copy it to a safe folder where it won’t accidentally get deleted. 

This tutorial assumes that you create the folder ~/intelFPGA/licenses and copy your license file there. 
9. We need to set the LM_LICENSE_FILE environment variable globally so that Questa knows where to find 

the license file. To do this, create /etc/environment.d/90quartus-license.conf and populate 
it with the following text. Make sure to use the username you installed Questa for and the correct name of your 
license file. You will need superuser privileges to create this file. 
LM_LICENSE_FILE=/home/YOURUSERNAME/intelFPGA/licenses/LR-XXXXXX_License.dat 

10. Restart your computer so that the changed environment variable takes effect. 
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11. By default, Questa aggressively optimizes your circuit designs so much that the outputs of your simulations 

will not be visible in the Quartus VWF viewer. To fix this, we need to replace the VWF viewer’s library file 
with a modified version that sets Questa to not optimize your designs while simulating. Download 
libedt_wedtq.so and copy it into ~/intelFPGA_lite/22.1std/quartus/linux64. Make sure to 
replace the older version of this file in the destination. 

12. Open Quartus and navigate to Tools->Options. In the Options window, select EDA Tool Options 
in the left panel. In the text boxes next to the Questa and Questa – Intel labels, insert the path to Questa’s bin 
folder. The default install location uses the path 
/home/YOURUSERNAME/intelFPGA/22.1std/questa_fse/bin. Click OK to save the simulator 
settings. Now you will be able to use Questa from the Quartus VWF editor. 

      
 
 
The Questa GUI does work for Linux (unlike Modelsim), but using Questa from its GUI (such as for Digital 
Design) leads to the over-aggressive optimization that can break some simulations. To disable this, go to 
Simulation->Design Optimization->Visibility, and click the radio button next to Apply full 
visibility to all modules. 
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Appendices 
Obtaining a Questa License 
Questa is the newest simulator provided by Intel. It supports modern hardware and uses modern dependencies, 
but it unfortunately requires a free license to use. Getting a Questa license is a somewhat involved process. Only 
follow these instructions if you are installing Questa. If you are using ModelSim as your simulator you do not 
need to get a license. 
1. Using Google Chrome or Chromium, navigate to the Intel Self-Service Licensing Center. The website will not 

allow you to get a license if you use Firefox. Click Enroll for Intel® FPGA Self Service 
Licensing Center (SSLC)and create an account. I would recommend signing up using your UF email. 
The enrollment process may require you to download the Microsoft Authenticator app onto your phone for 
two-factor authentication. I have not found a way to circumvent this requirement. 

2. Once you have activated your account, go to the Home Page for the Self-Service Licensing Center and click 
on Sign up for Evaluation or No-Cost Licenses. 

 
3. Click the radio button next to Questa-Intel FPGA Starter Edition. Type 1 in the # of seats box 

at the bottom of the page. Leave all other rows in their default values. You must do these steps in exactly this 
order or the page will automatically refresh. See the below screenshot. Check the license agreement 
checkboxes below the table and click Next. 

 

 

https://fpgasupport.intel.com/Licensing/license/index.html
https://licensing.intel.com/psg/s/
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4. In the window that appears, click New Computer under Create a New Computer 

  
5. Give the computer a memorable name. Under License Type, select Fixed. This creates a single-user 

license tied to your individual computer. Under Computer Type, select NIC ID. This will tell Intel that 
your computer will be identified by its network card. Under Primary Computer ID, type in the hardware 
ID of your network card (found earlier in your operating system’s Questa installation tutorial). The hardware 
ID should only include hexadecimal digits (0-9, a-f). Make sure to remove any spaces, dashes, or colons in 
the number. The form should look like the below screenshot, but with a different Computer Name and Primary 
Computer ID. Finally, click Save, make sure the correct computer is selected, and click Generate. 
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6. Look for an email from authorization@intel.com sent to the address you used to create your Intel account. A 

license file named LR-XXXXXX_License.dat should be attached to the email. Download that file and 
return to the Questa Installation Tutorial. 

 
Sources 

• https://stackoverflow.com/questions/18704913/unable-to-lock-chain-insufficient-port-permissions 
• https://wiki.archlinux.org/title/Intel_Quartus_Prime 
• https://cdrdv2-public.intel.com/666293/quartus_install-683472-666293.pdf 
• https://web.archive.org/web/20220614084754/https://ecen3350.rocks/static/usb-blaster.pdf 

 

https://stackoverflow.com/questions/18704913/unable-to-lock-chain-insufficient-port-permissions
https://wiki.archlinux.org/title/Intel_Quartus_Prime
https://cdrdv2-public.intel.com/666293/quartus_install-683472-666293.pdf
https://web.archive.org/web/20220614084754/https:/ecen3350.rocks/static/usb-blaster.pdf
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